Advanced mXrap Training

Basic Map3d Module Creation

This basic module will create the tools required to visualise ‘blast by blast” map3D results and the

induced seismicity. Map3D results are also used to chart the stress condition at the source of the

induced seismic events.

Map3D data

0 0.5

The outcomes for this exercise are to become familiar with:

o

CSV imports

Variables

Range Filters and Composite Filters
Marker styles/Menu Definitions
3D View, Chart View, Table View
Aliases

Table Calculations (simple)

Table Maps

Surveys

Inference: App Definitions, Panel Views, Window Definitions

Extension exercises are provided to reinforce and further develop skills established during the basic
module creation.

Support Email: support@mxrap.com




Table of Contents

~N

LCToY ] o =] =Y =T [P 4
IMPOIt MAP3D RESUILS ...vviiiieiiiee ettt e e et e e et e e e st a e e e seatseeeesasaeeesansaeeesnnnaeeenan 5
VIeWiING MaP3D RESUILS ..eeiuviieeieiiiee ettt ettt e sttt e e st e e s sbe e e e s sbaeeessabeeeessbtaeessnneaeessnnes 6
Map3D Data and Marker SEYIES ......uviieecieie ettt e e et e e e ratae e e ssaeaeeeeennaaeeean 8
REFINING ThE 3D VIBW ottt et e et e e e st te e e e s atae e s enabeeeeenbeeeeenbeeeeennrenas 10
5.1 Setting up a variable for MINING SLEPS ..vivvciiii i 10
5.2 Configuring CHPPING VOIUMES ....cccoiiiee ettt tee e e rae e e earae e e e rabae e e enreeas 11
53 CONTIGUIING SUIVEYS .oeiiieiiee ettt ettt e e e e etee e e e ta e e e e bae e e ssabaeeeentaeeeenabeeeeennsenas 12
54 ISOSUITACES 4 TraNSPAIENCY .c.uvvviiiiiiieeeecttee e ettt e esiteeeesareeesssaeeeesbbeeeessreeesssreeesssnseeessnnsens 14
SEISMIC EVENTS .. 16
6.1 YT T 4 [P 17
Filtering EVENTS fOr STOPS wuiiiiiiiii ittt e s e e e st e e e st e e e e s nbeeeeenareeas 20
7.1 Filtering EVents fOr STEPS: TIME ..ouiiii ettt et e e e are e e e e are e e e e abee e e enreeas 20
7.2 Filtering EVeNts fOr STEPS: SPACE ... .uiii ittt e e e e e erae e e e eabe e e e eeareeas 29
7.3 Charting RESUILS ..oeieiiiee et e e e et e e e e bae e e s sabee e s e sabeeeeenareeas 31
INtErface CONSEIUCTION ...ttt st sttt e sbeesaeesaee e 33
8.1 Variables PAn@l.... oottt 34
8.2 MENU DEFINITION 1.ttt s s s et r e e e s 35
8.3 WiINAOW DEFINITION ...ttt st s e 36
8.4 PN o] ol B L] 11011 4o o - UTRR 37
8.5 [ Lo AN T o T Y=L AU TP 38
EXEENSION EXEICISES oeiiiiiiiiiiiit ettt e e s e s e e s e e e s s e s 40
9.1 EQSY MO ... ..ttt e e e et e e e st te e e st be e e e s bbaeeeaabaeeeaaraeeeenbeeeeenraeas 40
9.1.1 Y Y T Y AV [T SRR 40
9.1.2 CNAIES ettt bbbttt et b e h e h e sat e sa bt ettt ebe e bt e sbeesheeeaeeenrean 40
9.1.3 INEEITACE ..t 40
9.2 Harder IMOTE. ...ttt st ettt sbee s e e r e sbeesreesane e 40
9.2.1 Associate Information from the Blast Database.......c..coocuerieeiiiienniiniciceeeeee 40
9.2.2 Calculate maximum shear stress for the Map3D results.......c.ccoveeeeciiieieciiee e 41

9.2.3 SErESS CeII RESUITS....ccciiiiieieieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeee ettt eeeeees 41




Kyle Woodward Basic Map3D Module Creation
Paul Harris Advanced mXrap Training — 31/06/2014

APP USER
INTERFACE

8.3 Other 8.3 Map3D
Windows Window

Final Map3D App
Overview

8.1

8.2 Map3D
Variables

Menu

1.0 mXrap
Root

Panels

e 30 ANALYSIS
3.0 Tables 3D View | w| N DOW
5.3 Site ~Seismic 3.0Map3D’ . '
Surveys e | Event Tools (series) (series)

6.1 Events 7.1 Event
Menu Def Composite 4.0 Map3D
Filter Menu Def

6.1 Mag. c nerc
Scaling - -
Marker Isosurface

Marker

6.1 Mag.
Marker

7.1 Time

Difference M.pso

Table Calc 7.2 Event -

Map3D TOO'S

i SETTINGS
i WINDOW

7.1 5tep Tablemap
Advanced Training - Cheat Sheets Page 3

Date
Tablemap

Event Map3D
Linking Tools




Kyle Woodward
Paul Harris

1 Getting Started

Basic Map3D Module Creation
Advanced mXrap Training —31/06/2014

First things first, we need to setting up the root for module creation

Windows Explorer

C:/mXrap/Advanced
Training/root_Tasmania_Advanced

Place the required data in the root folder
#Tasmania Map3D - root_Tasmania_Advanced
Contains:

Step by Step .inps (for Surveys)

Total Mine .str (for Surveys)

Results .txt

Step Dates .txt

mXrap software — Configure Root

Configure the root for development

C:/mXrap/Advanced Training/root_Tasmania_Advanced

mXrap software — User Role

Configure your role

i.e. *Home /*Admin App

mXrap software — Apps

Get started by opening ¥*Home /*Admin App. This will open a
Settings Window

Menu: Workspace — Analysis
Window

This will open an Analysis Window

TIP: Put the Analysis & Settings Windows on different Monitors

3D View

Click on the centre of the 3D view to get the focus. Press “R” on
keyboard to Reset the view.

Advanced Training - Cheat Sheets
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2 Import Map3D Results

Import of Map3D results
Settings Window 2 *New -2 *Import CSV * Import CSV J
4
*New/Import CSV Start by saving this tool. Save As: — 8
| Save As .:L Auto Apply
Folder: #Map3d App k>
Save Appl
Name: Import Map3D Results E’
#Map3d App — Import For the Input File: Browse to the Results.txt
Map3D Results
#Map3d App — Import Configure the format of this file: Ignore Rows that start with * and Multiple
Map3D Results -CSV Space Delimited
Format Delimited Field Configuration

Field Separators
Tab Semicolon Comma

V| Space  Other:

| Treat consecutive delimiters as one

Skip blank cells at the start of the row
Ignore lines that start with any ot these characters: | (eg for handling a space-separated file

7] # (hash) | Other: = with extra spaces at the start of each row)

#Map3d App — Import Add the required columns:
Map3D Results —

Name (type).
Columns

Location (3 columns of X,Y,Z)
S1 (Number)

S2 (Number)

S3 (Number)

Sfc (Number)

Step Number (Number)

#Map3d App — Import Check this import is doing what you think it should be! Open the Results tab
Map3D Results — Results | for a preview. TIP: This is important. If the info doesn’t come in correctly it
will cause headaches when it is used ‘downstream’

* Mining step ﬂ

* Point format: x,y,z sl s2 s3 sfc step#
3015.080800 4480.000000 985 .008000 126.
3015.000000  4475.000000 985.000000 126
3015.0800800 4438 . 000080 980 .0080008 126.
3015.080800 4475 . 000088 980.008008 126.%
3015.080800 4480.000000 975.008000 126.]
3015.000000  4475.000000 975.000000 126.6
3015.000088080 44368 .000000 9708.000008 128

3015.080800 4475 . 000088 970.008008 126,
IBIC QAGREARGR AARA DOARARR QEC QOOMAGH 197

[0, [ TR Ny

SRR R R R R R

=
2@ W~
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3 Viewing Map3D Results

Creating a table and 3D View of modelling results

Analysis Window >*New ->*Table View  create * Table View; \

Page Settings (Panel) >
Configure Page —
Columns Table

Open table configuration and fill in the fields
Table: #Map3d App / Import Map3D Results /
Filter: *All Rows

ID: #Map3d App/ Import Map3D Results /

Select the columns for display:

|| All Rows
3l *Home
o b1 #Map3d App
«+ |%| Import Map3D Results
x|

X Location
|%| Location ([x}

Save As: Folder: #Map3D App, Name: Map3D Results Table

Problem!!! We can see from this table view that there are quite a few rows (500k+). So let us have a think
about what we what in 3D view...

We wish to view the grid of each step independently of the previous/following step. Ultimately, we need
to limit this table to have a subset of data to plot in 3D... back to the Settings Window!

Settings Window - *New ->*Range Filter * Range Filter k:‘J

*New/Import CSV

Save As:
Folder: #Map3d App
Name: Mining Step Range Filter

#Map3d App — Mining
Step Range Filter

Configure this tool:
Table: #Map3d App / Import Map3D Results /

Columns: Step number. HINT: ‘Drag and Drop’ From the bottom window
onto the top ‘[ ] AND’ Green bar.

Configure Row: Double click this new row to ‘open’ it. Tick on the boxes, and
lets limit the data to step number 4 by setting limits ‘4 to 4’. (We will revisit

Save! = #Map3d App / Import Map3D Results [/ step number
4tod

OK that should do the trick...

back to the Analysis Window

Advanced Training - Cheat Sheets Page 6
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Analysis Window 2 *New = *3D View

1
Create * 3D View

Page Settings (Panel) —
Configure Page —
3D View — Series

Open 3D View configuration page, click Add, then Points, and fill in the fields:

Series Name: Map3D Grid

Icon: dot

Table: #Map3d App / Import Map3D Results /

Filter: #Map3d App / Mining Step Range Filter (Just made this!)
ID: #Map3d App/ Import Map3D Results /

Location: #Map3d App/ Import Map3D Results / Location

Save As: Folder: #Map3D App, Name: 3D View

Page Settings (Panel) —
Configure Page —
3D View — Marker Menu

Let’s set up a basic marker menu from what already exists... just so we can
see something. We will be revisiting this...

Data Isosurface

Marker Menu:
(coloursfshapes)

Marker Menwu:
(sizes)

Marker Menwu:
(3D attenuation)

Marker Menus Comments

| f@InterfaceMarker Style Menu [

Generic Marker

| j@Interface Marker Style Menu [

Blank

| j@Interface Marker Style Menu [

Generic Distance Attenuation

| Clear |
| Clear |

| Clear |

Can’t see anything? Make sure your markers are on, Click on the 3d viewer,
and press R (zoom to extents)

Problem!!! Where did our new views get to, | can’t see them on the top tab of the analysis window...?!

Head to: *mXrap — Tabs — Show Tabs — Visible Tabs — Tick

the #Map3D App.

This shows a tab with ALL the views saved in this app. We will

have to do this for our variables when we make them later.

*m¥rap  *Home  *Mew | #Map3d App |
I 30 View

Map3D Results Tablel

¥

“* mixrap

Configre Pagen k
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4 Map3D Data and Marker Styles

In the last step, we set up ‘Page Settings (Panel) — Configure Page — 3D View — Marker Menu’...
Now we will make our own menu containing the only the existing basic markers we wish to see, and
a few we have made. Let’s set up some basic marker styles for this table.

Settings Window - *New = *Menu Definitions =y mmmmﬂ_!
k

*New / *Window Save As: Folder: #Map3d App, Name: Marker Style Menu
Definition

#Map3d App — Marker Click right on the window space —
Style Menu Add new tool/Marker Style/!/Black Ring

Menu Mame Linked Toel Order Type

4 Menu
I i

Black - Ring 'E"lack_mng 100 Tool

Rename the ‘Menu/Black - Ring’ to ‘Black — Ring’ (Double click on menu)

Menu Mame Linked Tool Order Type
I i

Black - Ring 'E"Iack_mng 100 Tool

Save

Analysis Window —> Page | Let’s go back to the Analysis window and put this menu into the
Settings (Panel) > configuration.

Confl_gure Page — | Data | Isosurface | Marker Menus | Comments
3D View — Marker Menu

Marker Menu: =Map3d App |
#Map3d App
£l {colours/shapes) Marker Style Menu l Clear I
Marker Menu: |/ @Interface Marker Style Menu | =
W !
(sizes) Blank Clear

Marker Menu: |/ @Interface Marker Style Menu /
(3D attenuation) Generic Distance Attenuation

Clear

Save
We will now have our own (boring old plain) limited markers

Markers as:
[Black. -Ring - J

Problem!!! Black rings don’t tell us anything... let’'s make some of our own maker styles for Map3D
columns. Back to the Settings Window!

Advanced Training - Cheat Sheets Page 8
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Settings Window 2 *New 2> *Marker Style

*New / *Marker Style Save As:
Folder: #Map3d App,
Name: SFC
#Map3d App — SFC Configure this marker style to plot colours based on the SFC Preview

column in the Map3D table.

Scheme: Symbol-colour Scheme

Short Label: SFC

Basics — Input: Table: Import Map3D Results, Column: SFC
Basics — Ranges: Max:10, Min 0

Ranges — Auto Max — Symbol: Sphere

Ranges — Auto Max — Colour Ramp: Linear

Ranges — Auto Max — Start Colour: Red(ish)

Ranges — Auto Max — End Colour: Blue(ish)

Check the Preview!

Save

(Fixed_Min)
(Fixed_Max)
SFC

@ null

[ 10
o 9
[ ] 8
] 7
[ 6
[ 5
@+ 4
QT 3
o+ :

#Map3d App — Marker
Style Menu

Add this new marker to your Marker Style Menu

Click right on the window space — Add new tool/Marker Style/#Map3D

App/SFC
Name: SFC

Menu Definition

Menu Mame  Linked Tool Order Type
17
Black - Ring Black - Ring 100 Toel
#Map3d App /
SFC

SFC 100 Tool

Save

Analysis Window 2> #Map3D 23D View

Page Settings (Panel) —»
Markers As — SFC

Try Viewing your new marker ‘SFC’

Advanced Training - Cheat Sheets
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5 Refining the 3D view

Basic Map3D Module Creation
Advanced mXrap Training —31/06/2014

So we have our results in there and are getting somewhere with the makers but it is hard to audit

these results because we can’t see inside the blob of points, can’t adjust mining steps, and there are

no site surveys.
Let’s do some work to configure this 3D view further to enable:

o Filtering based on mining step
o Clipping
o Surveys

o Isosurfaces + Transparency

5.1 Setting up a variable for mining steps

Settings Window - *New - *Variables

* Variables J
k_

*New / *Window Save As:
Definition Folder: #Map3d App

Name: Variables
#Map3d App — Variables | Expose the variables to user by checking the Values | Columns

tick box.

| Funnee variahles tn nser
Add New Variable: Name: Mining Step ' T
Number <«
lAdd New Variable "‘k

#Map3d App — Variables | Configure to variable (number) as shown. Mining Step
- Mining Step (Number Default: 1 Value:  Using default
Variable)

Min/max: 0 and 7 (Corresponds to the

mining steps) Default: 3

Do NOT allow this number to be null Minimum: (] o

Do NOT allow the units to change Maimum: [7] 7

Save Allow value to be Mull

| Do not allow units to change

#Map3d App — Mining
Step Range Filter

Configure Row: Double click this new row to ‘open’ it. Configure the ‘link’
buttons for the upper and lower limits.

Variable: #Map3d App/Variables/Mining Step
Click on the ‘[ JAND’ Green bar to close

Save

Advanced Training - Cheat Sheets

Page 10




Kyle Woodward Basic Map3D Module Creation
Paul Harris Advanced mXrap Training —31/06/2014

Analysis Window 2#Map3D 23D View

Problem!!! Variables (Panel) — ....Nothing here!!! Remember how we had to expose the ‘views’ in the
module... we have to do the same for variables

Head to: *mXrap — Tabs — Show Tabs — Visible Variables — Tick the #Map3D App

This shows a tab with ALL the variables saved in this app.

&

7 ¥ #Map3d

i [ App Visible Tabs Visible variables

3 Variables

A=) Showe All Variables

._,% Mining Step : !

! Diagneostics

i 1 : | Standard Data
B - |[¥f] #Map3d App
£
Problem!!!

Adjusting this variable doesn’t show much change at the extents... Let’s “clip” though the middle and see
what’s happening.

5.2 Configuring Clipping Volumes
Analysis Window 2> #Map3D 3D View

Page Settings (Panel) > Configure the clipping volumes using the table already set up for the site.
anfigure Page — Table: !/Clipping Volumes/Dynamic Clipping/Clipping Volumes Table /

Clipping Volumes
Filter: !/Clipping Volumes/Dynamic Clipping/Clipping Volumes Table /*All Row

Name: !/Clipping Volumes/Dynamic Clipping/Clipping Volumes Table
/Mineplan Name

Minimum: !/Clipping Volumes/Dynamic Clipping/Clipping Volumes Table /
Max Location [Clipping Volumes]

Maximum: !/Clipping Volumes/Dynamic Clipping/Clipping Volumes Table
/Max Location [Clipping Volumes]

Save

Explanation: This table we just put into the configuration contains all the predefined volumes, which is
shown in the Clipping Volumes Table (Blue Arrow).

Reminder: To clip, tick on the scissors, click on Clip Volumes, Select the level (or levels), View! (red arrows)

Advanced Training - Cheat Sheets Page 11




Kyle Woodward Basic Map3D Module Creation

Paul Harris Advanced mXrap Training —31/06/2014
Perspective 3D navigation

#Map3d App / 3D View #Map3d App / 3D View

Page Settings

BB8 Comments ] Titles and Panel | Series ] Settings

(controls
[ Clip Volumes

Volumes for clipping

Table : [! /Clipping Volumes/Dynamic Clipping /J
Clipping Volumes Table /

e

Name : 1fClipping Volumes/Dynamic Clipping /
Mineplan Name [Clipping Volumes] /

. L Minimum :  |!/Clipping Volumes/Dynamic Clipping /
[7] 0790 Level . g o\ VA Min Location [Clipping Volumes] /

[] 0805 Level

[7] 0815 Level Maximum : {!/Clipping Volumes/Dynamic Clipping /
: : Max Location [Clipping Volumes] /

7] 1080 Level
[7] 1090 Level e
] 1120 Level -
[¥] 1130 Level

5.3 Configuring Surveys

Analysis Window 2#Map3D 23D View

Page Settings Add and configure a new Survey Series
(Pam_el) > Series Name: Site Basic

Configure Page —

Series Icon: Truck (My fav. for surveys)

Survey Set: #Site Setup/#Site Basic Setup / Basic site surveys

B Foints: Map3D Grid

Series Type: Survey
. Survey: Site Basic

Series Mame:  Site Basic

Survey Set: [#Site Setup/# Site Basic Setup [ Basic site surveys

Cornments

laddd o xj [ w |

Points Down

Survey L;‘

We now have access to all the site surveys in this view. Good for geology and things not in the map3D
data folder, however, we don’t have the exact mining sets. Let’s bring those in too. Back to the Settings
Window!

Advanced Training - Cheat Sheets Page 12
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Settings Window = *New = *Survey Source -';'3

*New / *Survey Source

Save As:
Folder: #Map3d App
Name: Map3D App Surveys

#Map3d App — Map3D
App Surveys

Configure this tool. You can play around with the colours and transparency;
however, | will just cover the basics here.

Base Folder: #Tasmania Map3D

Total Mine (Floor String).str - This will need the coordinates flipped due to
the file type. Click on this row and head to input config:

Total Mine (Floor String).str

Axis Configuration {reguires cache rebuild)
Override
X ¥
Column 2 | <-- sWap = | Column 1
[] Megate k| Negate

Rebuild Cache for All: Click!

Save

Analysis Window 2> #Map3D 23D View

Page Settings Add and configure this new survey set to the 3D View

(Panel) —»
Configure Page —

Series Name: Map3D

Series Icon: Truck (My fav. for surveys)

SAVE

Survey Set: #Map 3D App / Map3D App Surveys

Try visualising surveys and clipping the grid. Change the steps!

Map3D Grid
SFC

[ ] 10
[ ] 8
[ ] 6
(] 4
Q 2
[ ] 0
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5.4 Isosurfaces + Transparency

3D view is looking better...
isosurfaces instead.

but the grid is still a bit hard to see through... so let’s render some

Settings Window > New>* MarkerStyle

*Ne,” / *pankEF St”|e

Problem!!! I'm lazy.

Let’s just duplicate the one we already made using ‘Save As’ and modify the duplicate.

Name: SFC (Iso)

#Map3d App — Variables | Configure to variable (number) as shown.
—SFC (Iso) Scheme: Symbol-colour Scheme
Short Label: SFC (Iso) CHANGED
Basics — Input: Table: Import Map3D Results, Column: SFC
Basics — Ranges: Max:10, Min 0
Ranges — Auto Max — Symbol: Sphere
Ranges — Auto Max — Colour Ramp: None CHANGED
Ranges — Auto Max — Start Colour: Blue CHANGED
Ranges — Auto Max — End Colour: NONE CHANGED
So we have to add some rows to give the marker style discrete boundaries.
L
| add 'l Dekete |
Ry
Preview (Fixed_Min) (Fixed_Max)
o0 @ o
Configure these new rows (See Screen Shot)
Save
Upto Symbol  Start Colour End Colour  ColourRamp  Mumber of Colours  Transparency [0..100]
1 Auto Max [ sphere_64:64 - Mo rsmp)  Mone Mo ramp g0
25 [ sphere_54x64 Mo rsmp)  Mone No ramp &0
325 [ sphere_64x64 No ramp) MNone Neo ramp 40
41 [ sphere_64x64 - Mo ramp)  Mene Mo ramp 0

#Map3d App — Variables —SFC (Iso)

#Map3d App — Marker
Style Menu

Add this marker style to the Marker Style Menu, same as the previous
markers but here’s a HINT:

Advanced Training - Cheat Sheets Page 14
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Menu Definition

Menu Mame

15

Linked Tool

Order Type

Black - Ring 'E'“lack_mng 100 Tool

#
SFC 5;“:':3“3" APP/ 100 Tool
° a
SFC (1S0) S,E‘fcagggf‘p” 100 Tool

Analysis Window 2> #Map3D 3D View

Page Settings
(Panel) —»
Configure Page —
Series

Duplicate the “Map3D Grid” Series

Ctrl + Shift + Click and Drag the series name and drop it below on the list.

You can use the ‘up’ and ‘down’ to adjust the order of series.

Rename the Series Name:
Map3D Iso

Change the Icon: bullseye2ring
(looks a bit like surfaces)

Open the Isosurface tab for this
new series

Show an Isosurface instead:
Enable

Assumed Grid Space: 5

Results:

#Map3d App / 3D View

Series Type: Points

Map3D IS0

Icon: @ bullseye Zring

Series Mame:

Data

Isosurface | Marker Menus | Comments

Show an Isosurface instead

Assumed
Grid Spacing faor
Isosurface

[¥] 5

[¥] Perspective (] 30 navigation 2z

2
3

[@ & [@[@mero150
o 4 0 [BEREE
@ oEwme ]

@ Map3D 150

[V] Markers as:
[sFc aso)

[ cip

gt

[7] "Clean" the isosurface model

Decimate %
[T] Decimate: Preserve Topology
Norm: Feature Angle (deg) 60 [+

] Norm: Fiip Normals

Depth Sort [First Point -

X
myrap

Map3D 150
SFC (1s0)

° 10

) 9

J ol

o [ ] 7

ol ) 6

) 5

o 4

[+] 25

o 1

[ 0
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6 Seismic Events

Basic Map3D Module Creation
Advanced mXrap Training —31/06/2014

We now wish to visualise the seismic responses to each mining step. Let’s plot the Seismic Data.

Settings Window = *New - *Alias Hes

A

*New / *Alias

Save As:
Folder: #Map3d App

Name: Seismic Events

#Map3d App — Seismic
Events

Configure this tool. You can play around with the colours and transparency;
however, | will just cover the basics here.

Source Table: !|/Data Tables / Events /

Add new Alias —> Add many columns at once: !/ Data Tables/id, date,
location, localMagnitude

Also: add !/ Event Quality / Quality Events

. #Map3d App [ . |1/Data Tables /
Host Table: S e o Source Table: SR

Column and Value Aliases

Show hints
Add MNew Alias
Alias Name Type Source Column
date Dates |/Data Tables / Events / date
id IDs (32 bit int)  !/Data Tables / Events / id
localMagnitude  Mumbers !/Data Tables / Events / localMagnitude
location Points I/Data Tables / Events / location
Quality Events Filter !/Event Quality / Quality Events
Save

Explanation: We could just use columns from !/Data Tables / Events /
directly, however, we will see every column for this table and have to deal
with long path names.
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Analysis Window 2#Map3D 23D View

Page Settings Open 3D View configuration page, click Add, then Points, and fill in the fields:

(Pam'el) - Series Name: Seismic Events Data | Isosurface | Mark
Configure Page —

3D View — Series | lcon: Sphere Table : #Map3d App |

Seismic Events [

Table: #Map3d App / Seismic Events /

i : . . Filter : #Map3d App [
Filter: #Map3d App / Seismic Events / Quality Events Seimic Eventts
lity Events
ID: #Map3d App / Seismic Events / id (LD ie =
Id: #Map3d A
Location: #Map3d App / Seismic Events / Location SeiS;E: E'u'eﬂfclsff
id

Save

Location : | #Map3d App [
Seismic Events |
location

Problem!!!

Marker Styles: There are no Marker Styles for the Events Table set up. If we didn’t use an Alias we would
have access to those used in the rest of mXrap, however, because the Alias is in practice a new table,
these need to be set up.

Filters: We passed though the quality filter so we don’t have to recreate those filters, however, we are
seeing all events... not just those which happened after the step (blast) was taken.

Let’s tackle the marker styles first then move onto the Filters.

6.1 Marker Styles

This is the same as the marker styles for the Map3D grid so: ILL GIVE YOU A BREIF OVERVIEW...
However, that is it!

Settings Window - *New - *Marker * Marker Style | \ Style

*New / *Marker Style Save As: Folder: #Map3d App, Name: Magnitude

Hints — Column: localMagnitude, Max: 2, Min -2 Auto Max, Sphere, Blue to
Red Linear Colour Ramp.

Preview (Fixed_Min) (Fixed_Max) Magnitude
e®¢ © © o o o o o o
! |
1

T — — — —

-2 -1.5 -1 -0.5 0 0.5 1.5 2
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Settings Window > *New > *Marker Style | =Marker Style!

k

*New / *Marker Style

Save As:
Folder: #Map3d App,
Name: Magnitude [Scale]

We HAVE NOT made one of these before. This lets us make large values look
larger and small values look smaller in the 3d view.

Scheme: Size scheme: Scale based on a value
Input: #Map3d App / Seismic Events / localMagnitude
Input Minimum: -1

Input Maximum: 1

Scheme: |5ize scheme: Scale based on a value -

Short Label for Legend:

Scale the size of the markers {(note: only supports Mumber columns for an ir

Table: #Map3d App [ Seismic Events

TELE Column: #Map3d App [ Seismic Events [ localMagnitude
Input Minimum: 7 -1 ] Link
Input Maximum; N
nput Maximum: | " Link:

Settings Window = *New =2 *Menu Definitions  *New Menu Def'u'iﬁon_!

A

*New / *Window
Definition

Save As:
Folder: #Map3d App,
Name: Marker Style Menu [Events]

#Map3d App — Marker
Style Menu [Events]

Add:

Simple ‘Black ring’ or something similar
Magnitude (just created)

Magnitude [Scale] (just created)

Menu Mame Linked Tool Order Type
Black - Ring !E'fack Ring 100 Tool
Magnitude [Scale] f}:gﬁiﬂj‘f{’siale] 100 Tool
Magntiude ﬂ:gﬁfﬂ j‘epp " 100 Tool
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Analysis Window 2>#Map3D 23D View

Page Settings (Panel) >
Configure Page —

3D View — Points: Seismic
Events — Marker Menu

Configure this marker menu for the events series.

| Data | Isosurface | Marker Menus Comments

Marker Menu;
(colours fshapes)

Marker Menu;
(sizes)

Marker Menu:
(30 attenuation)

#Map3d App f
Marker Style Menu [Euents]‘ C

#Map3d App f
Marker Style Menu [Euents]‘ C

| f@Interface Marker Style Menu [
Generic Distance Attenuation

Map3D IS0
SFC (Iso)
. e 10
‘e 8
.
o s
.9
[ . [ ] 5
g
®e *
9
. o 25
P
(]
)
(] 0
. 3
Seismic
. » Events
.- o4 Magnitude
*. @ 2
«
s .
[+] 1
o S gt
.
[ ] 0
.
[ ] 1
[ ] 2
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7 Filtering Events for Steps

Up until now we have been manipulating single tables i.e. making marker styles for a column in the
events alias table. Now we have to combine information from multiple tables.

7.1 Filtering Events for Steps: Time

First Step will be to deal with creating a temporal link .This is a stepping-stone that will allow us to
relate Map3D results (Step Number to Seismic Events (Dates)

Step Dates.txt

User - |
Created FHROEA
File Link ta:irag
Table Map
Map3D Seismic
Results Events
Step _# Dates

Location \Spﬂtiﬂl Link "aLDCﬁ’[iDIl

mXrap
Table Map

Let us bring in the extra info we need to link step number for dates via the Step Dates.txt

Step Dates.txt

User - I
empora
Conaiad Link mXrap
Table Map
Map3D Seismic
Results Events
Step .# Dates
Location \Spatial Tk "_.'Locaticm
mXrap
Table Map
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Settings Window > *New > *Import CSV = Import CSV |

*New/Import CSV Start by saving this tool: Save As —
| Save As /| Auto Apply

Folder: #Map3d App k

Save Appl
Name: Step Dates Link E’

#Map3d App — Step For the Input File: Browse to the Step Dates.txt
Dates Link

#Map3d App — Step Configure the format of this file:
Dates Link Add the required columns:

Step Number (Number)

Dates (Date) Date format : yyyy-MM-dd hh:mm:ss.zzz

Important Note: Dates can be tricky. The format in the file must EXACTLY
match the format in mXrap. The kicker is that every time excel opens a file, it
changes the date format to ‘its default’. Be Aware of this!! Solution is to re-
specify the right custom format in excel. So the standard format generally is:

mXrap: yyyy-MM-dd hh:mm:ss.zzz

excel: yyyy-MM-dd hh:mm:ss.000
wput File: || #Tasmania Map3D/Step Dates. tut

Applied config

will load file: #Tasmania Map3D/step Dates.txt

Columns C5V Format Translation Cache Results

MName Type Date Format E|

Step Number |Mumber - |

MName Type Date Format IZl

Dates |Date b | yyyy-MM-dd hh:mm:ss.zzz

SAVE

#Map3d App — Step Check this import is doing what you think it should be! Open the Results tab
Dates Link for a preview.

TIP (again): This is important. If the info doesn’t come in correctly it will
cause headaches when it is used ‘downstream’
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We now have a link between the data, but how do we actually go about saying this event happened
after this mining step? We will be using a table map tool, although there are many ‘other’ ways.
First, we will relate the link to the seismic events.

User Step Dates. txt
Created Temporal
File Link TaNGAR
Table Map
Map3D Seismic
Resullts Events
LSIEI;# Dates
ocanon ; ; :
\ Spatial Link ’__?Locatmn
mXrap
Table Map
Settings Window 2> *New - *Table Map *Table Map |
*New/Table Map Save As: Folder: #Map3d App, Name: Table Map [StepDates to Events]
Hint: Be very clear with naming these, very easy to lose track of what is
going where
#Map3d App —> Before you start filling in boxes, have a think about the result we what to
Table Map achieve.

[StepDates to Events] We want any event that happened after the step date to be assigned that
step number and date.
Map the last foreign row that is < primary [tick!]
Ergo: map the last step date info that is less than (before) the event date.
Primary Table: #Map3d App/ Seismic Events /

Filter: *All Rows

Values: Date
Foreign Table: #Map3d App/ Step Dates Link /

Filter: *All Rows

Values: Date

AND
#Map3d App/ Step Dates Link / Step Number
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#Map3d App/ Step Dates Link / Step Dates

Configuration
Map exact matches

@ Map the last foreign row thatis < primary
Map the last foreign row thatis <= primary
Map the first foreign row thatis = primary

Map 1 LINK nearestitem

Primary Table Foreign Table

Table : #Map3d App | Table :
Seismic Events /

Filter :

Group by (1) :

* Al Rows

Filter :

Group by (1) :

#Map3d App /
Step Dates Link /

= all Rows

Group by (2

Group by (2) :

Values ; #Map3d App | Values : #Map3d App [
Seismic Events [ Step Dates Link f
date Dates
Locations : Locations :
ax radius Mapped Foreign Columns
D sea
Step Numbs #Map3d App / | | Rename
i o P THMBEr |step Dates Link /
lapped Primary Columns (Mumnbers) Step Number | [Delete |
Only for "Map all” mode
#Map3d App / | | Rename
Step Dat:
Add an extra EPUALES | cien Dates Link /
(Dates) Dates [Delete |

Add an extra

Now this is quite a trick step, so let’s make sure we have got this right be creating a table view for

the events.

Analysis Window = *New = *Table View

Create * Table V'lewE k‘

Page Settings (Panel) >
Configure Page —
Columns Table

Open table configuration and fill in the fields
Table: #Map3d App / Seismic Events /

Filter: *All Rows

ID: #Map3d App/ Seismic Events / id

Select Date, Step Dates and Step Numbers for display
4

4 [%| Seismic Events
|| Quality Events
X date
[ id

4 % Table Map [StepDate:
X Step Dates
|%| Step Number

Save As: Folder: #Map3D App, Name: Events Table
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Audit the events table to make sure any event that occurs after a step date has that step date and
step number in addition columns.

date Step Dates {} Step Number
834 2812-83-86 13:685:24.680868 2012-83-686 13:83:55.6.. E 7 i
5835 2812-83-86 13:84:55.888 2812-83-86 13:83:55.8.. 7
836 2812-83-8c 13.:84.:54.888 2812-83-86 13:83:55.6.. 7
¥~ 837 2812-83-86 13:684:33.880 2012-83-86 13:83:55.6.. 7
¥~ B38 2812-83-86 10:604:00.800 2012-62-19 18:868:47.0.. B
839 2812-83-86 A87:25:43.606 2612-62-19 183:86:47.0.. B

Now we can link that step number column to the previous variable we have made!

Settings Window = *New =>*Range Filter *Range Filter k:‘J

*New/*Range Filter Save As: Folder: #Map3d App, Name: Mining Step Range Filter [Events]

#Map3d App — Mining Configure this tool:
Step Range Filter [Events) Table: #Map3d App / Seismic Events /

Columns: Table Map [StepDates to Events] Step number. HINT: ‘Drag and
Drop’ From the bottom window onto the top ‘[ JAND’ Green bar.

Configure Row: Link to Variables: #Map3d App/Variables/Mining Step
Click on the ‘[ JAND’ Green bar to close

Save

Table: oot epdD R

Range Filter Structure

4 [J]:AND

#Map3d App / Import Map3D Results / step number
| Table: #Map3d App / Variables
Column: #Map3d App / Variables / Mining Step to Table: #Map3d App / VariablesColumn: #Map3d App / Variables / Mining Step

...back to the Analysis Window

Analysis Window > #Map3D App—>3D View

Page Settings (Panel) > Change the Filter

Configure Page — Filter: #Map3d App / Mining Step Range Filter [Events]
3D View — Series —

Points: Seismic Events

PROBLEM!!!

This means that we lose our Quality Filter... that is no good. We need to combine the filter we just made
with the quality filter.
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Settings Window 2 *New - *Composite Filter w

k

*New/*Composite Filter

Save As: Folder: #Map3d App, Name: Events Composite Filter

#Map3d App — Events
Composite Filter

Configure this tool:

Table: #Map3d App / Seismic Events /

Columns:

#Map3d App / Mining Step Range Filter [Events]

And

Map3d App / Quality

HINT: ‘Drag and Drop’ From the bottom window onto the top

Save

...back to the Analysis Window

Analysis Window = #Map3D App—>3D View

Page Settings (Panel) >
Configure Page —

3D View — Series —
Points: Seismic Events

Change the Filter
Filter: #Map3d App / Events Composite Filter

PROBLEM!!! How long after the step, are the events allowed to be?

Now, analysis considers all the events in the mine from the beginning of one-step until the next step. We
only care about a subset of these events. We will deal with the spatial aspect later, but now let’s finish up

the temporal filtering by finish
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Settings Window - *New - *Table Calculation

I
*Table Calculation g

k

Warning: This tool lets you program in Javascript. We are moving away from the “as long as you
have filled the boxes in right” to ... programming. If you miss one character in here, the computer
will not forgive you. It will execute the code exactly how you have told it. If you program a loop

with no stopping criteria, it will not stop. That being said, with untold responsibility, comes untold

power.

*New/*Table Calculation

Save As: Folder: #Map3d App, Name: Time Difference

#Map3d App — Time
Difference

Configure this tool:

Step 1: Add an input table

Add new — Add an Input Table: #Map3d App / Seismic Events /

Assign JavaScript name: Events

Filter: IGNORE
Group 1: IGNORE
Group 2: IGNORE
Order: Date

Step 2: Add input/output columns.

#Map3d App / Seismic Event / date

JS identifier: event_date

IS identifier: step_date

JS identifier: time_difference

Click right on ‘data’ and select Add Input Column:

Click right on ‘data’ and select Add Input Column:
#Map3d App / Table Map [StepDates to Events] /

Click right on ‘data’ and select Add Output Column:

Save
You will need exactly this:
J5 Identifier In/ Out Type Table Column
4 Events IN Table Table zmaﬁd‘ﬂ‘pp’f,
eismic Events /
<Filter=> <Double-click to set>
<Group By... <Double-click to set=>
<Group By... <Double-click to set>
#Map3d App /
<Order= Tscceil;ir:; Dates Seisr':ic EvErF:ts_f
date
#Map3d App /
event_date IN Column Dates Seismic Events /
date
#Map3d App /
step_date  IN Column Dates Table Map [StepDates to Events] /
Step Dates
time_differ.. OUT Column MNumbers time_difference
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#Map3d App — Time Time to code! What we need is a simple “for loop’ that, for every row reads
Difference the event date, step date and writes the time difference. Note that ‘//’

before a line, ignores that line. Essentially comments.
You will need exactly this:

/I Switch on Javascript 'strict mode' for safer code.

"use strict";

/I start at the first event, until the last event, in increments on 1

/i is the index of the row in the event table. Note this index starts at ‘0’
for(let i = 0; i < Events.size(); i++){

/Iread in the time of the step and event

/lthis numbers are the number of milliseconds since 1970
let event_t = Events.read_event_date(i);

let step_t = Events.read_step_date(i);

/ What if they don't have a date?!
/I Check for this and only write if there is a date for both.
if(event_t !==null && step_t == null{
/l write out the difference.
/I This will be a positive number of milliseconds since the step.
Events.write_time_difference(i, event_t - step_t);
}
}

Analysis Window 2> #Map3D App > Seismic Events

#Map3d App / Seismic
Events /

Add the time_difference column to the z
. 4 || Time Difference
events table and audit your results x| t S,

Hint: Configure Page —

Results should look like this:

date

2914 | 2812-81-88 23:
2515 | 2@812-81-88 23:
2916 | 2@812-81-88 23:
20917 | 2@812-81-88 23:
2018 | 2@12-81-88 23:
2919 | 2812-@1-88 23:
2920 | 2812-81-88 23:
2921 | 2@812-81-88 23:
2927 | 2@812-81-88 23:
2923 | 2@812-81-88 23:

as:
ar:
a7
86
86
a6;
as:
as5:
as:
as:

24,
53.
43,
25.
17.
a7.
4.
a4,
16.
1z2.

| Step Dates | 4k Step Number Mining 5Step Range Filter [Events] time_difference
888 2812-81-88 23:82:51.8.. 3 333,808
8688 2812-81-88 23:82:51.8.. 3 382,800
888 2812-81-88 23:82:51.8.. 3 292,888
888 2812-81-88 23:82:51.8.. 3 214,888
888 2812-81-88 23:82:51.8.. 3 286,880
8ge 2812-81-88 23:82:51.8.. 3 196,808
888 2812-81-88 23:82:51.8.. 3 175,668
8688 2812-81-88 23:82:51.8.. 3 173,808
888 2812-81-88 23:82:51.8.. 3 145,888
888 2812-81-88 23:82:51.8.. 3 141,888

If not the error tab might provide some clues where things went wrong. (here is have a space in the code
where there shouldn’t be a space)

Inputs & Outputs

print{) output Error: - Data API Safety Options Engine Messages Debugger

ERRORS OCCURRED, you must fix the problem and then Apply or Sawve the Calculation
Program failed to compile
Script, line 18: SyntaxError: Unexpected identifier

Events.write time difference(i, event t - step t};

AP DADININ

SyntaxError: Unexpected identifier
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Settings Window 2> #Map3D App > Variables

#Map3d App — Variables | Add New Variable: Values | Columns
Name: Time Allowed After Step | Number - ";L:r
e L
#Map3d App — Variables | Configure to variable (number) as shown.

— Mining Step (Number
Variable)

Note: We must set the units, otherwise mXrap will think we mean
milliseconds

Default: 12 Hours

Min: 0 Hours, No Max

Do NOT allow this number to be null
Do NOT allow the units to change

Save

#Map3d App — Mining
Step Range Filter [Events]

Drag the time_difference column onto this filter.

Configure Row: Double click this new row to ‘open’ it. Configure the ‘link’

buttons for the upper and lower limits.

Lower Variable: 0

Upper Variable: #Map3d App/Variables/Time Allowed After Step
Click on the ‘[ JAND’ Green bar to close

Save

Analysis Window —
#Map3d App — 3D View
& Events Table

Add the Mining Step Range Filter [Events] filter column to the events table

and audit your results

Test the variables functionality in the 3D View.
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7.2 Filtering Events for Steps: Space

Ok so now we have events that happen soon
after the step, however, anywhere in the

Temporal
mine. We now wish to limit how far away Cllzﬁll]:d Link mXrap
from the model we allow event to occur. Table Map
Unlike the temporal link we have all the
i - i Map3D Seismic

information we need, the location of the

User Step Dates.txt

Results

map3D results and the location of the Step & Events
seismic event. Again, we use a table map to Loca'liion Dates
make this connect, however, in a slightly Spﬂflﬂl Link -“-‘_’,LOCBIIOII
different way. mXrap
Table Map
Settings Window 2> *New - *Table Map *Table Map |
*New/Table Save As: Folder: #Map3d App, Name: Table Map [Map3D to Events]
Map Hint (again): Be very clear with naming these, very easy to lose track of what is
going where
#Map3d App — | We want the closest item (result point) for every event.
Table Map Primary Table: #Map3d App/ Seismic Events /
[Map3D to
Events] Filter: *All Rows

Locations: Location
Foreign Table: #Map3d App/ #Map3d App / Import Map3D Results

Filter: *All Rows

Locations: Location
BUT WAIT!!! : This isn’t quite right; we can’t guarantee that events get the
results from ‘their’ step. We could filter in this TableMap so we only calculate
these results for the step we are looking at but this may be slow. Always better

to do the calculations ‘up front’. We get around this by using the ‘Group By’
option: Step Number.

¥ Group by (1) #Map3d App [ Group by (1) : #Map3d App /
Table Map [StepDates to Events] [ Impart Map3D Results [
Step Mumber step number

AND Add an extra (we need to pass the info to the events)
#Map3d App/ Import Map3D Results / s1
#Map3d App/ Import Map3D Results / s2
#Map3d App/ Import Map3D Results / s3
#Map3d App/ Import Map3D Results / sfc
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Note: There is a limit on the Maximum Search Distance. In this case, 100m will
be fine, but this may need to be modified depending on the application

Mearest Items Configuration

Maximum distance to search: 100 | Link |

Settings Window > #Map3D App > Variables

#Map3d App - Add New Variable: Values | Columns
Variables '

Name: Maximum Distance from Map3D Number ®r

4 e

lAdd New Variable "Jk

#Map3d App —> Configure to variable (number) as shown.
Variables — Maximum | paayt: 5 (Note: Grid Spacing)
Distance from Map3D

Min: 0

Max: 100 Note: Remember the Max Search Dist in the table map? —
100m limits that search, so it doesn’t make sense to let this go past
where there won’t be results anyway.

Do NOT allow this number to be null
Do NOT allow the units to change

Save

#Map3d App — Mining | Drag the #Map3d App/Table Map [Map3D to Events] column onto this
Step Range Filter filter.

[Events] Configure Row: Double click this new row to ‘open’ it. Configure the
‘link’ buttons for the upper and lower limits.

Lower Variable: 0

Upper Variable: #Map3d App/Variables/ Maximum Distance from
Map3D

Click on the ‘[ JAND’ Green bar to close

Save
Analysis Window — View the Mining Step Range Filter [Events] filter column to the events
#Map3d App — 3D table and audit your results

View & Events Table Test the variables functionality in the 3D View.
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Now we have seismic events with map3D results associated with them AND seismic events filtered
for each step. Charts can be constructed showing the various aspects of these two tables. Any
combinations could be explored; however, this example will assess the relationship between Sigma 1,

Sigma 3, and Magnitude.

Analysis Window 2> *New >*Chart  |create * Chart|

A

*New / *Chart

Save As: Folder: #Map3D App, Name: Sigma 1 vs Sigma 3

Page Settings (Panel) —>
Configure Page — Series

Configure this tool:

| Add up |

|
A
| I Diown |

Remowve

Add a new series:
Configure this Series:
Data Tab:
Series Name: Events
Series Icon: Sphere_64x64
Filter: #Map3d App / Events Composite Filter
Id: #Map3d App / Seismic Events / id
X: #Map3d App / Table Map [Map3D to Events] / s1
Y: #Map3d App / Table Map [Map3D to Events] / s3
Markers Tab:

Data Markers Advance
Configure this to the Marker Style Menu

[Events] We previously made.

#Map3d App [
Marker Style Menu [Events]

#Map3d App [
Marker Style Menu [Events]

Configure Axis:
Bottom: M Show axis title, ticks and labels
Title: Sigma 1 [MPa]
Left: M Show axis title, ticks and labels
Title: Sigma 3 [MPa]

Show axis title, ticks and labels

Botkorn

Title: [7 Sigma 1 [MPa]

afk

Note: Scale Type lets you use a log axis, or a date axis, dependent on
what is being plotted
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Scale Type:
Rotate label
e . _ .| Date and Time
Note: The can be limits put on the max and min axis values. Handy if
some extreme values ruin the chart.
Minimum: EIII
Maximunm: [Ee—
250
Configure Titles and Panel:
Header: Sigma 1 vs Sigma 3
Size: 14
Justify: Centre
Comments Titles and Panel | Series | Axes | Appearance |
Header: g:gmz évs Size: 14 =] Justify:
Sigma 1 vs Sigma 3 Events
= Magnitude
120 i - & null
. Lo o o 2
100
- K ] 1.5
T a0 o .
g 80 — . o 1
= ~ : i'r'h .
60 ®® . (®] 0.5
2 ‘T8
S 40— s p [ 0
5 B
Z -
20 — . O -0.5
- -1
0- ® ®
R T T T T T T T T T T T T T T T T T IIT[Ix'rlap . -1'5
] a0 100 150 200 250 300
L ] -2

Sigma 1 [MPa]
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The interface is a way to limit what the user can see and use. We will create a basic one here that won’t cover all the features but will provide a good start
for anyone wanting to make their own ‘proper interfaced apps’. Below is a basic overview of how the interface tools work together. We will start from the
bottom and work up, keeping in mind that we have already created the required 3d, chart and table views along with variables.

This is what we see when we first
start mXrap.

These are the windows visable in that
particular app. Not limited to 'our’
setting subfolder

These is what goes into our app
window. Some apps may have
multiple windows specifically for that

app.

The views we have made!

We also include a panel of variables
that we need.
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Map3d
App

I_l_l

Map3D Other
Window Windows %
Map3D

Menu
1

8.1 Variables Panel

Settings Window > *New > *Panel View | =panelvie:: |

Ry
*New / * Save As:
Folder: #Map3d App / Interface
Name: Map3D Variables
#Map3d App — Configure this tool:
Interface — Add a ‘slot’ for a variable:
I Add "] Up |
Line
Text
Value Display
Variable Editor |, 4
—d
Embed a Tool I[anot{er Panel, Pick, Table View)
Specify the ‘Variable to Edit’
Variable Editor Variable to edit:
Table: #Map3d App [ Variables
Column: #Map3d App [ Variables / Mining Step
History /Bookmark codename:
Complete this for our 3 Variables:
#Map3d App / Variables / Mining Step
#Map3d App / Variables / Time Allowed After Step
#Map3d App / Variables / Maximum Distance from Map3D
SAVE
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Map3d
APP
Map3D Other
Window Wlndows /

&
I B

Map3D

Variav

8.2 Menu Definition

3D VIW

Settings Window = *New = * Menu Definition *lhﬂhnneﬁ_iﬁ.-gj
k;

*New / * Menu Definition | Save As:
Folder: #Map3d App / Interface
Name: Map3D Menu

#Map3d App — Interface | Configure this tool:

— Map3D Menu Click Right = Add Tool — ‘Browse to the views and panels we require’

Save the tools under appropriate subfolders by giving them ‘Directory
Names’ e.g. Tables/Events Table

FINAL CONFIGURATION:

Menu Definition
Menu Mame Linked Tool Order Type
4 3D View
: #Map3d App [
3D View 30 View 100 Tool
4 Charts
. . #Map3d App /
Sigral vs Sigma 3 Sigma 1 vs Sigma 3 100 Tool
4 Panels
i #Map3d App/Interface ,.Ir
Variables Map3D Variables Tool
4 Tables
#Map3d App /
Events Table Events Table 100 Tool
#Map3d App /
Map3D Results Table Map3D Results Table 100 Tool

SAVE
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8.3 Window Definition

Basic Map3D Module Creation
Advanced mXrap Training —31/06/2014

Other

Windows w

Settings Window = *New = * Window Definition

*New / * Window Save As:
Definition Folder: #Map3d App / Interface
Name: Map3D Window
#Map3d App - Here all we want to do is set the ‘Menu Definition” to the Tool we just made in
Interface — Map3D the previous step
Window

Note: We will be revisiting this tool when we go to capture the initial tabs of
the app.

Menu Definition | Hot Keys | Initial Tabs | Appearance |

#Map3d App/Interface [
Map3D Menu

Clear

() Use old menu (MOTE - will be remaoved in future, please migrate to new "Menu Definition™)

@ Menu Definition:

SAVE
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8.4 App Definitions

( MEES" )

Map3D Other
Window Wlndows /

Map3D

Menu

Map3D
Variav

Settings Window = *New = * App Definitions [=apsbefncenl

A
*New / * App Save As:
Definitions Folder: #Map3d App / Interface
Name: Map3D App
#Map3d App —> Configure this tool:

Interface - Map3D
App

Similar to the menu definition, just click right on the space and browse to the

windows that we need in there:
#Map3d App — Interface — Map3D Window
1/System Monitor / ~System Health Monitor Window

Change the Open at Start for the Map3D Window to True (by double clicking the

default False)

#Map3d App/Interface / Map3D App

Title: Map3D - Advanced Training App

Windows

[ star this tool

) Show all defined windows

@ Limit available windows to:

[7] server Mode: Automatically write cache files for loaded data sources, show server control

Window Mame Tool ID
. #Map3d App/Interface /
hepil Ninclo Map3D Window

| .
~Systern Health Monitor Window AL T

SAVE

Open at Start

~Systemn Health Monitor Window

True

Falze
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8.5 Final App Set up
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There are a few last things we need to set up in the App so let’s start by make sure all settings are

saved in both the Settings and Analysis Window.

Close mXrap and re-open. Then Open the app we have made:

-
x ACGE m¥rap Apps

C:fUsersfKyle Home /Dropbox/Individual

Config Root: Shares - Paul/Advanced

[ Switch "] [RelcadConﬁg]

Training {root_Tasmania_~Advanced

User Role: * Home [/ * Admin Role [ Switch "] [Set as default workspace user]

[7] Automatically log me in next time

Apps App Workspaces

- [Dpen App's Blank Workspace]

mXrap System --> Server

or, open a saved workspace:

Getting Started --» Basics
Getting Started --> Selections |

(OPEM) Map3D - Advanced Training App i

Disclaimer:

Mote: Apps can only be opened once

The Australian Centre for Geomechanics disdaims all responsibility for the correctness of any methods and procedures, or
correctness of data displayed or analysed by this program, or for the consequences resulting from the use thereof,

ACG mXrap version 4.1.0-prel7 WkLan [64 bit] Sat Jun 7 2014

We now need to set up the app how you would like it to appear upon opening it. Make sure you
have the Variables Panel open, but the rest is up to you! Here is mine:

-
. Map3D - Advanced Training App: Map3D Window - ACG mXrap 4.1.0-prel7 = | B ||
File Windows Help 3DView Charts Panels Tables

ReloadData K7 (a Workspaces
Variables Al =0 view /v — + [lir— g
é [ Perspective (/] 3D navigation 3D View a
el Mining Stey
E Jess ) ° Map3D IS0 Seismic Controls BR
E e — |
= a4 SFC (Is0) EVEﬂt_S y Clip Volumes T
I | Y 10 Magnitude = gl |5
. || Legends B
@  Time Alowed After Step (D] ® L ] 2 —‘] I |
; o o [Bemes
i3 ol . 5
i 4 (O Glvee 150
2 o
Maximum Distance from @ o 1 — o anl
Map3D < m r
5 Seismic Events
; ®
[ ] ° 0
o 4 [¥] Markers as:
Magntiude -
o 25 @ 1 [] Show Mull Colaurs
[¥] sizes as:
A o ! Magniude [Scale] -
) [ ] n e 2
10 e =
= ) ars
- Cartoan -
3 date | tocalMagnitude [ 9 [ 2 | 3 | s | B
1| 2e12-81-20 13:00:48.008 -8.579777 192... 117... 182... 2.47.. |;| 9] select
2| 2e12-81-28 13:81:35.008 -B.877369 126... 1@8... 31.7. 1.53. | )l | [Z] show only selected
| 3| 2012-e1-20 13:01:51.600 -B.673897 123... 1@1.. 48.3. 2.15. 7] Highiight selected
4| 2e12-01-20 13:02:07.000 -9.129213 112... 101... 14.6. 1.29. o
5| 2e12-81-20 13:02:56.000 -1.55379 131... 95.7.. 45.8. 1.93. g
6| 2812-81-20 13:03:11.008 £.233499 111... 188.. 52.5. 2.50.. [¥] Legend:
7| 2812-81-28 13:83:17.060 -B.763796 144... 1@7... 52.2.. 1.86.
8| 2812-81-28 13:83:23.000 -B.996567 139... 1@7... 77.3. 2.36.
9| 2e12-01-20 13:04:06.000 -9.711684 142... 185... 56.5. 2.83. g
10| 2e12-81-20 13:87:43.000 -1.35372 124... 11@... 61.1. 2.66. @
Active: 0, Waiting: 0, of 0 Ready
)
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Now we need to capture this view. To do this go the

Menu: Windows — Settings Window

Then open the Initial tabs in the Map3D windows tool:

Basic Map3D Module Creation
Advanced mXrap Training —31/06/2014

#Map3d App — Interface — Map3D Window —Initial Tabs (Tab)

Enable initial tabs capture:

| Menu Definition I Hot Keys | Initial Tabs I Appearance |

[

| Enable initial tabs capture

When enabled, a menu item will appear in any related open windows.
Click the window's menu item "File - > Capture Initial Tabs", and it will update the initial

Now, go back to your app window and capture those tabs by heading to the File menu. You will

receive confirmation:

Wlndows Help 3D View Charts Panels
Workspaces

Undo

Redo

LS

Save

Reload Configuration

Show Reload Controls...

-
Reload Data I Initial Tabs Captured

S0

Capture current centre tool's state ) I

Edit current centre tool

Capture Initial Tabs
Goto this Window Definiticn tool
Goto this Window Definition tool (new tab)

Goto this Window Definition tool (new win)

Exit

Tabs have been captured.

Mow go and save the configuration of the
Window Definition in the Settings Window

Finally, back to the Setting Window to save the tool...

= | B [ |
, | .
#Map3d App/Interface / Map3D Window [ star this tool

Menu Definition I Hot Keys | Initial Tabs Appearance

Enable initial tabs capture

‘When enabled, a menu item will appear in any related open windows.

Current Initial Tabs:
Initial state, captured 1 left tabs, 2 centre tabs

Click the window's menu item "File —> Capture Initial Tabs™, and it will update the initial tabs configu

4| 1l

Saved

Clear Unused

i

And we are done!
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9 Extension Exercises

9.1

Easy Mode

9.1.1 Marker Styles

Basic Map3D Module Creation
Advanced mXrap Training —31/06/2014

Make additional Marker styles (suitable for isosurfaces) for Map3D results (s1,52,s3)

Bring in additional event source parameters (energy, moment etc.) and create

marker styles for these new columns

9.1.2 Charts

Make an additional charts which shows:

Magnitude vs SFC

In the same chart, add Magnitude vs other map3D results

Sigma 1 vs Sigma 3

9.1.3 Interface

Spruce up the Panel View by adding lines and comments

9.2 Harder Mode

9.2.1 Associate Information from the Blast Database
Modify the ‘time difference’ table calculation to output an additional column ‘Hours Since

Step’. Plot this value against information from the map3D results.

Here is some information about the blasts associated with each of these modelling steps.

This information exists in the blasts table. Plot the blast, and only the blast associated with

each mining step.

Step Name Blast | Time

Number ID

3 Stope # 177 1150 | 40505 | 2012-01-08 23:02:51.000
Level

4 Stope # 180 1150 | 40509 | 2012-01-20 12:59:45.000
Level

5 Stope # 185 1150 | 40515 | 2012-01-31 15:25:54.000
Level

6 Stope # 192 1150 | 40523 | 2012-02-19 18:00:47.000
Level

7 Stope # 195 1150 | 40527 | 2012-03-06 13:03:55.000
Level
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9.2.2 Calculate maximum shear stress for the Map3D results
This is quite easy, however, use a row calculation (this isn’t a table calculation) to find:

S§1—S3
Tymax = 2

We haven’t been through this type of tool but is similar to entering an equation for excel.

E.g. create a new column that is equal to (column x + column y)/2;

If you name your input columns s1 and s3, the only piece of code you need is:

return (s1-s3)/2;

The rest... | will let you try and figure out.

Extensions of this include:

o Make a marker style for this new column

o Map these values to events

o Make an event marker style for these values

o Make a chart plotting tmax vs magnitude for the events during a step.

9.2.3 Stress Cell Results

In addition to the modelling results there is also a csv file called ‘Stress Cell Sensor Readings.csv’.

This file contains direction stress

results (scaled by magnitude) for some sensors around the area of

stoping. The format is simply some points to visualise these vectors along with columns for the
component (principle ‘0’, secondary ‘1’, or tertiary direction ‘2’). Disclaimer: | forgot to reorder these

components for some sensors so

the tertiary/secondary may be bigger that the primary. Ignore this,

likely a bug in my pre-calculations somewhere.

Also has a column for the sensor ID and step number. Create a sub folder ‘Stress Cell Results’. Import
this file and plot in 3D using component and sensor marker styles. Filter results for step number.

HINT PREVIEW:

#Map3d App / 3D View
U || Legends -
O, & D | BMap3DGrid
NI O
o b [Hoee ]
@)% D [Evepn |
Sl
< T »

m Stress Cell Results

[V] Markers as:

Selection | Page Settings

m

| variables

[Component >

[Z] show Nl Colours
[7] sizes as:

Advanced Training - Cheat Sheets

[7] Perspective [¥] 3D navigation

#Map3d App / 3D View

DIEGIIoSTTS
| ! Standard Data

11 Events Import V3 CSV
{ #Map3d App

1> Import Results
Range Filters

2 > Mining Step Range Filter [Stress Cells]
Marker Styles

2> Component Markerstyle

2 > Sensor Markerstyle

2> Step Number Markerstyle
Menu Definitions

B
Y, myrap
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10 Appendix: Step by Step Presentation

Final Map3D App
Overview

8.3 Other
Windows

8.4 Map3d

App

8.3 Map3D
Window

8.2 Map3D

Menu

Basic Map3D Module Creation
Advanced mXrap Training —31/06/2014

APP USER
INTERFACE

81
Variables

Panels

1
1.0 mXrap
Root
m = Tables

3.0
3D View

Menu Def

6.1 Mag.
Scaling
Marker

Composite
Filter

Seismic
Events
Event Tools s
6.1 Events 7.1Event

7.1Time
Difference
Table Calc

7.1Step
Date
Tablemap

Event Map3D
Linking Tools

7.2 Event -
Map3D
Distance

Tablemap

7.0 STEP
DATES
LINK

ANALYSIS
WINDOW

EXOLVETED]
Results
(Series)

4.0 Map3D
Menu Def

5.4 SFC
Isosurface
Marker

4.0SFC
Marker

Map3D
Tools

SETTINGS
WINDOW

1. Getting
Started

APP USER
INTERFACE

ANALYSIS
WINDOW

SETTINGS
WINDOW
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mXrap
Root

mXrap
Root

3D View

1 bl
W ETED]
Results
(Series)

Map3D
Mining
Step Filter
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4. Map3D Data
& Marker Styles

mXrap
Root

Basic Map3D Module Creation
Advanced mXrap Training —31/06/2014

APP USER
INTERFACE

ANALYSIS
WINDOW

© MAP3D Map3D
RESULTS
Tools

SETTINGS
WINDOW

5. Refining the
3D View

APP USER
INTERFACE

ANALYSIS
WINDOW

Map3D :
Results 1
(Series) :

4

Map3D
Menu Def

SFC
Isosurface SFC Marker
Marker

 MAP3D Map3D
RESULTS
Tools

SETTINGS
WINDOW
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6. Seismic Events APP USER

INTERFACE
ANALYSIS
WINDOW
Seismic Map3D
Event Tools (series) (Series ‘
-----
Menu Def Map3D |
Menu Def
Marker
Map3D
Tools
SETTINGS
WINDOW
7.1 Events Time APP USER
Fi|tering INTERFACE
mXrap
Root
ANALYSIS
WINDOW
Seismic Map3D ( |
vents esults
Event Tools oories (o) ‘ \
Events ____-
Menu Def Composite (VETED)
Filter Menu Def ‘ |
) Magnitude
M:Ag;:s"de :,%S‘E Isosurface SFC Marker
I Marker
Map3D
________ Tools
—
L
Event Map3D i DSIITEES i i nm Ji SETTINGS
Linking Tools [i.. "% 1] ] ! WINDOW
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7.2 Events Space
Filtering

EDAVE

mXrap
Root
Seismic
Events
Event Tools G

Events
Menu Def

Magnitude Magn\_tude
Marker selling
Marker

Event

Filter

Composite

Time
Difference
Table Calc

Step Date
Tablemap

Event Map3D
Linking Tools

Map3D
Distance
Tablemap

Basic Map3D Module Creation
Advanced mXrap Training —31/06/2014

APP USER
INTERFACE

ANALYSIS
WINDOW

Map3D
T
(Series)

]

SFC
Isosurface
Marker

SFC Marker

Map3D
Tools

SETTINGS
WINDOW

7.3 Charting
Results

Surveys

Event Tools

Events
Menu Def

Magnitude Magn\_tude
Marker el
Marker

Event

Filter

Time
Difference
Table Calc

Step Date
Tablemap

Event Map3D
Linking Tools

Seismic
Events
(Series)

Composite

Event -

[VETED

Distance
Tablemap

APP USER
INTERFACE

ANALYSIS
WINDOW

Map3D
Results
(Series)

]

SFC
Isosurface
Marker

SFC Marker

Map3D
Tools

SETTINGS
WINDOW
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8 Interface
Construction

Map3D
Window

Other
Windows

(ETE]
Menu

Basic Map3D Module Creation
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APP USER
INTERFACE

3D View

Seismic
Events
(Series)

Surveys Surveys

Event
Composite
Filter

Events
Menu Def

Magnitude
Scaling
Marker

Event

Magnitude
Quality

Marker

Time
Difference
Table Calc Event -

W ETED]
Distance
Tablemap

Step Date
Tablemap

Event Map3D
Linking Tools

ANALYSIS
WINDOW

(ETE]]
Results == Variables
(Series) I

Map3D
Mining
Step Filter

Y ETED]
Menu Def

SFC
Isosurface
Marker

SFC Marker

SETTINGS
WINDOW
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